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1 Overview

Dual channel, H-bridge, brushed DC motor driver with quadrature encoder decoding, current
sensing and onboard micro-controller for control, automation and robotics application.

Dual channel motor driver, Toshiba TB9054FTG integrated circuit (IC) incorporates each
channels with two outputs for direct drive of a brushed DC motor. PWM control with low-
resistance enables highly energy efficient drive output. The PWM1A and PWM1B pins specify
forward, reverse and brake modes for motor 1, and the PWM2A and PWM2B pins specify
these modes for motor 2.

The output current capacity is 6.5 A (typical), which is suitable for a wide range of application
like small size ground robots and a lot of automation projects.

Inbuilt ESP32 micro-controller makes easier programming with Arduino like programming
interface with hassle-free use.

2 Application

Robotics application such as ground robots, self-balancing robot and automation application
etc.

3 Specifications

• Dual channel, H-bridge brushed DC motor driver.

• Control Input: PWM with frequency from 1− 10 khz.

• Forward/reverse/brake modes.

• High voltage side output current monitoring.

• Protection: Stop output for supply under voltage, over current, over temperature.

• Operating voltage: VBAT = 4.5 to 28 V, VCC = 4.5 to 5.5 V, VDDIO = 3.0 to 5.5 V.

• Operating temperature range: Ta = −40 to 125oC

• Encoder Decoder: Onboard dual channel quadrature digital encoder decoding for motor
speed measurement with onboard power supply to encoder sensor.

• PID control with onboard motor speed and current sensing.

• USB serial interface between micro-controller and the computer for two-way communi-
cation firmware upload, control, communication and sensors data streaming.

3.1 Technical Data

The power rating the MekRobo brushed DC motor controller is listed in Table 3.1
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3.2 Schematic

Table 1: Rating
Symbol Parameter Unit Min Typ Max
VBAT Power Supply/Battery Voltage V 4.5 12/24 27
I1/I2 Output Current to Motor Channel A/B A 0 - 6.5

3.2 Schematic

Fig. 1 indicates the relevant pin-out, configuration jumper, USB-C connections and other
relevant components.

Figure 1: Motor Driver Schematics.

Table 2: Description
Parameter Symbol IN/OUT Description

Motor 1, 2
1A, 2A OUT Motor 1, 2 Power A
1B, 2B OUT Motor 1, 2 Power B

Encoder 1, 2

GND GND Ground
3.3V Power Power to Encoder

ENC 1A, 2A IN Encoder Channel A for Motor 1, 2
ENC 1B, 2B IN Encoder Channel B for Motor 1, 2

SPI ON/OFF - Config. Enable/Disable SPI of Driver IC TB9054FTG
Motor Current 1, 2 I1, I2 OUT Measurement terminal of Motor 1, 2 current
USB - IN/OUT Connection to Computer for Data read/write
Power Source/Supply VBAT IN Battery Power/ External Power Sources
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3.3 Dimensions

3.3 Dimensions

In addition to the dimension specified in Fig. 2, sufficient clearance should be maintained
for heat dissipation and avoiding electrical short circuit. There should be at-least 10 mm
clearance in the bottom side and 20 mm clearance in the upper side.

Figure 2: Controller Board Dimensions.

4 Application Case

One minimum application each for direct PWM sweep and RPM PID control for single as well
dual channel has been included as example of the library.

4.1 Connection

The minimal circuit diagram has been presented in Fig. 3. The controller must be connected
to a PC through the USB-C for serial monitoring.

4.2 Software Setup

MekRobo BDC driver can be controlled by onboard ESP32 micro-controller. It can also be
controller with external micro-controller through external PWM pins.

Install Arduino-ESP32 support if it is not installed, following the step by step instruction in any
of the follwing links.

ESPRESSIF Official https://docs.espressif.com/projects/arduino-esp32/en/latest/installing.html

Unofficial link: https://randomnerdtutorials.com/installing-the-esp32-board-in-arduino-ide-windows-
instructions/

Download MekRob’s ESP32-motor-controller Arduino from the official MekRobo github repos-
itory using the link: https://github.com/mekrobo/ESP32-motor-controller.git.
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4.2 Software Setup

Figure 3: Motor Driver Connection.

It should download ESP32-motor-controller.zip file. In Arduino IDE go to Menu
- Sketch > Include Library > Add .ZIP Library· · · and choose the downloaded zip
file. You can see the confirmation if the library import is successful.

Then Install the dependency library ESP32Encoder frommenu - Sketch > Include Library
> Manage Libraries· · ·

After successful import of library Open examples from Menu - File > Examples > ESP32
MotorController· · ·

There are four examples: PWM, PWMChannel1, RPMControl and RPMControlChannel1.
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4.2 Software Setup

The required header files for all the examples are as follows. The config.h has all the pin-out,
motor specification, PID parameters etc. motor.h has the class MotorController that
control the motors.

Listing 1: header files
1 #include <Arduino.h>
2 #include <ESP32Encoder.h>
3 #include "config.h"
4 #include "motor.h"

The configuration parameter like PWM_FREQ, COUNTS_PER_REV, Timer Settings, PID param-
eters are presented as follows. These parameters may need changes for various application
scenarios.

Listing 2: Editable parameter in config.h
1 #define PWM_FREQ 7000 // PWM frequency in Hz
2

3 // Motor Specification
4 #define MAX_RPM 300 // motor maximum RPM at output shaft
5 #define MAX_ACC 20000 // motor Acceleration at base motor
6 #define COUNTS_PER_REV_1 2709.2 // motor 1 encoder’s no of ticks per rev motor

shaft
7 #define COUNTS_PER_REV_2 2709.2 // motor 2 encoder’s no of ticks per rev motor

shaft
8

9 // Timer Settings
10 #define SENSOR_PERIOD_MS 20 // Sensor read period in ms (>=20 ms)
11 #define CONTROL_PERIOD_MS 40 // Control loop period in ms
12

13 // PID parameters for RPM control
14 #define Kff_1 0.7245 // RPM to PWM mapping for motor 1
15 #define Kfr_1 4.128 // PWM for drive friction of motor 1
16 #define KP_1 2 // P constant for motor 1
17 #define KI_1 0.2 // I constant for motor 1
18 #define KD_1 0 // D constant for motor 1
19

20 #define Kff_2 0.7187 // RPM to PWM mapping for motor 2
21 #define Kfr_2 4.0236 // PWM for drive friction of motor 2
22 #define KP_2 2 // P constant
23 #define KI_2 0.2 // I constant
24 #define KD_2 0 // D constant

The class ESP32Encoder from <ESP32Encoder.h> is initialized as motor1_encoder,
motor2_encoder for motor 1 and motor 2 encoder ticks reading. The motor controller
class MotorController from "motor.h" is initialized with channel selection, Channel_1,
Channel_2 for using motor 1 and motor 2 respectively.
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4.2 Software Setup

Listing 3: Object calling
1 ESP32Encoder motor1_encoder, motor2_encoder; // Encoder objects for motor 1 and

motor 2
2 MotorController motor1(Channel_1); // Motor Controller object for channel 1
3 MotorController motor2(Channel_2); // Motor Controller object for channel 2
4

5 TaskHandle_t SensorReadHandle = NULL; // Sensor Reading Task Handle
6

The constant parameter for unit conversion factor are computed to avoid repeated computa-
tion during runtime.

Listing 4: Constant parameter
1 float TICKS2RPM_1 = 60000.0 / (COUNTS_PER_REV_1 * SENSOR_PERIOD_MS); // RPM

calculation factor for motor 1
2 float TICKS2RPM_2 = 60000.0 / (COUNTS_PER_REV_2 * SENSOR_PERIOD_MS); // RPM

calculation factor for motor 2
3 float VALUE2AMP = (3.3 * 1.7483) / 4095.0; // Assuming a 12-bit ADC and 3.3V

reference

Initialize the variables

Listing 5: Variables
1 rpm des_rpm = {0.0,0.0}, mes_rpm = {0.0, 0.0}; // Desired and Measured RPM

structures
2 current mes_current; // Measured current structure
3 int64_t last_pulse_count_m1 = 0; // store previous pulse count for motor 1
4 int64_t last_pulse_count_m2 = 0; // store previous pulse count for motor 2
5 int64_t pulse_count_m1 = 0; // current pulse count for motor 1
6 int64_t pulse_count_m2 = 0; // current pulse count for motor 2
7 char data_sensor[64]; // serial print buffer
8 // Additional variable required for RPM PWM control paste below

The sensor_read function which is attached to a dedicated core runs at an interval of SEN-
SOR_PERIOD_MS in miliseconds.

Listing 6: Sensor reading
1 /**
2 * @brief Sensor reading in a periodic interval of SENSOR_PERIOD_MS (miliseconds)
3 *
4 * @param parameter Empty
5 */
6 void sensor_read(void *parameter) {
7 const TickType_t xDelay = pdMS_TO_TICKS(SENSOR_PERIOD_MS); // read at every

SENSOR_PERIOD_MS
8 TickType_t xLastWakeTime = xTaskGetTickCount();
9 int i = 0;

10 for (;;)
11 {
12 // Read sensors here
13 pulse_count_m1 = motor1_encoder.getCount();
14 pulse_count_m2 = motor2_encoder.getCount();
15 mes_rpm.motor1 = (pulse_count_m1 - last_pulse_count_m1) * TICKS2RPM_1; // RPM

calculation channel 1
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4.2 Software Setup

16 mes_rpm.motor2 = (pulse_count_m2 - last_pulse_count_m2) * TICKS2RPM_1; // RPM
calculation channel 2

17 last_pulse_count_m1 = pulse_count_m1;
18 last_pulse_count_m2 = pulse_count_m2;
19 mes_current.motor1 = analogRead(MOTOR1_C) * VALUE2AMP; // Assuming a 12-bit

ADC and 3.3V reference
20 mes_current.motor2 = analogRead(MOTOR2_C) * VALUE2AMP; // Assuming a 12-bit

ADC and 3.3V reference
21 vTaskDelayUntil(&xLastWakeTime, xDelay);
22 }
23 }

Setup required for Serial printing, encoder attachment, and attaching the sensor reading
function to a dedicated core.

Listing 7: Setup
1 void setup() {
2 Serial.begin(115200); // For Serial printing
3 delay(100);
4 // Initialize encoders
5 ESP32Encoder::useInternalWeakPullResistors = UP;
6 motor1_encoder.attachFullQuad(MOTOR1_ENC_A, MOTOR1_ENC_B);
7 motor2_encoder.attachFullQuad(MOTOR2_ENC_A, MOTOR2_ENC_B);
8

9 // Additional setup code can be added here
10 delay(50);
11 xTaskCreatePinnedToCore(sensor_read, "SensorRead", 4096, NULL, 1, &

SensorReadHandle, 0); // Core 0
12 // RPM PID control setup code paste below
13 }

4.2.1 PWM Run

PWM sweep and sensor data printing for both the channel. For using only a single channel,
the variables and functions calling for the other channel should be cleaned.

Listing 8: PWM Sweep
1 void loop() {
2 // Changing PWM
3 for(int dutyCycle = 0; dutyCycle <= 80; dutyCycle++){
4

5 motor1.rotate(dutyCycle);
6 motor2.rotate(-dutyCycle);
7 data_sensor[0] = ’\0’;
8 snprintf(data_sensor, sizeof(data_sensor), "Motor1:: PWM:%d, RPM: %0.2f, Current

: %0.3f\n",
9 dutyCycle,mes_rpm.motor1, mes_current.motor1);

10 Serial.print(data_sensor);
11 data_sensor[0] = ’\0’;
12 snprintf(data_sensor, sizeof(data_sensor), "Motor2:: PWM:%d, RPM: %0.2f, Current

: %0.3f\n",
13 -dutyCycle,mes_rpm.motor2, mes_current.motor2);
14 Serial.print(data_sensor);
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4.2 Software Setup

15

16 delay(100);
17 }
18

19 for(int dutyCycle = 80; dutyCycle >= -80; dutyCycle--){
20

21 motor1.rotate(dutyCycle);
22 motor2.rotate(-dutyCycle);
23

24 data_sensor[0] = ’\0’;
25 snprintf(data_sensor, sizeof(data_sensor), "Motor1:: PWM:%d, RPM: %0.2f, Current

: %0.3f\n",
26 dutyCycle,mes_rpm.motor1, mes_current.motor1);
27 Serial.print(data_sensor);
28 data_sensor[0] = ’\0’;
29 snprintf(data_sensor, sizeof(data_sensor), "Motor2:: PWM:%d, RPM: %0.2f, Current

: %0.3f\n",
30 -dutyCycle,mes_rpm.motor2, mes_current.motor2);
31 Serial.print(data_sensor);
32

33 delay(100);
34 }
35

36 for(int dutyCycle = -80; dutyCycle <= 0; dutyCycle++){
37

38 motor1.rotate(dutyCycle);
39 motor2.rotate(-dutyCycle);
40

41 data_sensor[0] = ’\0’;
42 snprintf(data_sensor, sizeof(data_sensor), "Motor1:: PWM:%d, RPM: %0.2f, Current

: %0.3f\n",
43 dutyCycle,mes_rpm.motor1, mes_current.motor1);
44 Serial.print(data_sensor);
45 data_sensor[0] = ’\0’;
46 snprintf(data_sensor, sizeof(data_sensor), "Motor2:: PWM:%d, RPM: %0.2f, Current

: %0.3f\n",
47 -dutyCycle,mes_rpm.motor2, mes_current.motor2);
48 Serial.print(data_sensor);
49

50 delay(100);
51 }
52

53 }

4.2.2 RPM Control

The variable like PID parameters etc. specific to the RPM PID control should be also declared
in addition to PWM run cases.

Listing 9: Variables for RPM Control
1 int ctrl_pwm1 = 0; // control input PWM for motor 1
2 int ctrl_pwm2 = 0; // control input PWM for motor 2
3

4 // PID Parameters for Motor 1
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4.2 Software Setup

5 pid_param pid_param_m1 = {
6 .kff = Kff_1,
7 .fr = Kfr_1,
8 .kp = KP_1,
9 .ki = KI_1,

10 .kd = KD_1,
11 .pwm_max = PWM_MAX,
12 .integral_max = 100,
13 .integral_error = 0,
14 .prev_error = 0,
15 };
16 // PID Parameters for Motor 2
17 pid_param pid_param_m2 = {
18 .kff = Kff_2,
19 .fr = Kfr_2,
20 .kp = KP_2,
21 .ki = KI_2,
22 .kd = KD_2,
23 .pwm_max = PWM_MAX,
24 .integral_max = 100,
25 .integral_error = 0,
26 .prev_error = 0,
27 };

The callback function static void pid_loop_cb (void *args) attached to a timer interrupt,
computes the required control input as PWM and run motors accordingly by calling .rotate
member function at a set interval of CONTROL_PERIOD_MS.

Listing 10: RPM PID control loop
1 /** PID loop callback for RPM control with CONTROL_PERIOD_MS interval
2 *
3 * @param args desired rpm structure pointer
4 */
5 static void pid_loop_cb(void *args)
6 {
7 rpm *req_rpm = (rpm *)args;
8 ctrl_pwm1 = pid_compute(&pid_param_m1, req_rpm->motor1, mes_rpm.motor1);
9 ctrl_pwm2 = pid_compute(&pid_param_m2, req_rpm->motor2, mes_rpm.motor2);

10 motor1.rotate(ctrl_pwm1);
11 motor2.rotate(ctrl_pwm2);
12 }

Create a periodic timer interrupt with interval time of CONTROL_PERIOD_MSmillisecond and
attached the callback function static void pid_loop_cb (void *args) in setup.

Listing 11: RPM Control Setup
1 void setup() {
2 // Paste the common setup code here
3

4 // RPM PID control setup code
5 // PID control timer setup at interval of CONTROL_PERIOD_MS
6 const esp_timer_create_args_t periodic_timer_args = {
7 .callback = pid_loop_cb,
8 .arg = &des_rpm,
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4.2 Software Setup

9 .name = "pid_loop"
10 };
11 esp_timer_handle_t pid_loop_timer = NULL;
12 esp_timer_create(&periodic_timer_args, &pid_loop_timer);
13 esp_timer_start_periodic(pid_loop_timer, CONTROL_PERIOD_MS * 1000); //! interrupt

function callback for pid control
14 }

Runs a RPM sweeps in loop and print sensor readings for both the channel. For using only a
single channel, the variables and functions calling for the other channel should be cleaned.

Listing 12: RPM Sweep
1 void loop() {
2 // changing the RPM
3 for(int i = 0; i <= 80; i++){
4

5 des_rpm.motor1 = (float)(i*2); // Desired RPM for motor 1
6 des_rpm.motor2 = (float)(i*2); // Desired RPM for motor 2
7

8 //Sensor data print
9 data_sensor[0] = ’\0’;

10 snprintf(data_sensor, sizeof(data_sensor), "Motor1: PWM:%d, RPM:%0.2f, RPM: %0.2
f, Current: %0.3f\n",

11 ctrl_pwm1, des_rpm.motor1, mes_rpm.motor1, mes_current.motor1);
12 Serial.print(data_sensor);
13 data_sensor[0] = ’\0’;
14 snprintf(data_sensor, sizeof(data_sensor), "Motor2: PWM:%d, RPM:%0.2f, RPM: %0.2

f, Current: %0.3f\n",
15 ctrl_pwm2, des_rpm.motor2, mes_rpm.motor2, mes_current.motor2);
16 Serial.print(data_sensor);
17

18 delay(100);
19 }
20

21 for(int i = 80; i >= -80; i--){
22

23 des_rpm.motor1 = (float)(i*2); // Desired RPM for motor 1
24 des_rpm.motor2 = (float)(i*2); // Desired RPM for motor 2
25

26 // Sensor data print
27 data_sensor[0] = ’\0’;
28 snprintf(data_sensor, sizeof(data_sensor), "Motor1: PWM:%d, RPM:%0.2f, RPM: %0.2

f, Current: %0.3f\n",
29 ctrl_pwm1, des_rpm.motor1, mes_rpm.motor1, mes_current.motor1);
30 Serial.print(data_sensor);
31 data_sensor[0] = ’\0’;
32 snprintf(data_sensor, sizeof(data_sensor), "Motor2: PWM:%d, RPM:%0.2f, RPM: %0.2

f, Current: %0.3f\n",
33 ctrl_pwm2, des_rpm.motor2, mes_rpm.motor2, mes_current.motor2);
34 Serial.print(data_sensor);
35

36 delay(100);
37 }
38

39 for(int i = -80; i <= 0; i++){
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40

41 des_rpm.motor1 = (float)(i*2); // Desired RPM for motor 1
42 des_rpm.motor2 = (float)(i*2); // Desired RPM for motor 2
43

44 // Sensor data print
45 data_sensor[0] = ’\0’;
46 snprintf(data_sensor, sizeof(data_sensor), "Motor1: PWM:%d, RPM:%0.2f, RPM: %0.2

f, Current: %0.3f\n",
47 ctrl_pwm1, des_rpm.motor1, mes_rpm.motor1, mes_current.motor1);
48 Serial.print(data_sensor);
49 data_sensor[0] = ’\0’;
50 snprintf(data_sensor, sizeof(data_sensor), "Motor2: PWM:%d, RPM:%0.2f, RPM: %0.2

f, Current: %0.3f\n",
51 ctrl_pwm2, des_rpm.motor2, mes_rpm.motor2, mes_current.motor2);
52 Serial.print(data_sensor);
53

54 delay(100);
55 }
56 }

5 User Agreement

Copyright (c) 2025 - 2030 MekRobo Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the "Software"), to deal in the Software without restric-
tion, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

6 Revision History

Table 3: Revision History
Version Date Changes
Version 0.0.1 20-Dec-2025 Initial Release
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